Table of Contents

Introduction ......................................................................................................................... 5
Screen View .................................................................................................................... 7
Installation ........................................................................................................................... 8
Connections On Rear Panel ............................................................................................. 9
Installing Software ........................................................................................................ 11
Uninstalling Software .................................................................................................... 12
Analysis Modes .................................................................................................................13
Pulse Height Analysis ................................................................................................... 14
Multi Channel Scaling ................................................................................................... 15
External Multi Channel Scaling .................................................................................... 17
Operation ........................................................................................................................... 18
Live Mode ..................................................................................................................... 19
File Mode ...................................................................................................................... 20
Amp/HV/ADC .............................................................................................................. 21
High Voltage ............................................................................................................. 23
Amplifier Coarse Gain .............................................................................................. 24
Amplifier Fine Gain .................................................................................................. 25
ADC Conversion Gain ............................................................................................... 26
Lower and Upper Level Discriminators ........................................................................ 27
Presets ............................................................................................................................ 28
Preset Time ................................................................................................................ 29
Preset Integral ............................................................................................................ 30
Go, Stop and Erase ........................................................................................................ 31
Region of Interest (ROI) ............................................................................................... 32
Functions ........................................................................................................................... 34
Energy Calibration ........................................................................................................ 35
Isotope Matching ........................................................................................................... 36
Strip Background ........................................................................................................ 39
Load Spectrum ......................................................................................................... 40
Load Background ..................................................................................................... 41
Show Spectrum ......................................................................................................... 42
Show Background ..................................................................................................... 43
Overlay Spectra ......................................................................................................... 44
Strip Background from Spectrum ............................................................................. 45
Data Smoothing ............................................................................................................. 46
Menu Bar ........................................................................................................................... 47
File ...................................................................................................................................... 48
File Open .................................................................................................................... 49
File Save ..................................................................................................................... 50
File Load Setup ......................................................................................................... 51
File Save Setup .......................................................................................................... 52
File Load Library ...................................................................................................... 53
File Save Library ........................................................................................................ 54
Introduction

Hardware

The Universal Computer Spectrometer offers a unique solution for nuclear spectrometry using the PC platform. A 2K ADC combined with 8K of data memory and multi-channel scaling is ideally suited to scintillation spectroscopy and time related studies such as half-life decay.

Constructed in a sturdy, fully-shielded bench top enclosure with Universal Serial Bus (USB) computer interface, the multi channel analyzer contains many advanced features including computer controlled amplifier and high voltage for PM tubes, upper and lower level discriminators, on instrument data memory, and a comprehensive software package for use under Windows 98 or higher. (Windows 95 may be used if you have installed the USB patch.)

The UCS-20 requires only an available USB port and is designed to work seamlessly with USB-equipped PCs. For stability and low noise operation, the unit is AC-line powered with an auto-sensing power supply for 100-250 VAC operation. An on-board microprocessor acts as the master controller and data storage device, as well as the communication link directly to the USB interface.

The integrated amplifier and high voltage are fully compatible with most standard scintillation detectors, eliminating the need for special tube bases and external modules. For ease of setup and calibration, coarse gain, fine gain, high voltage, and lower and upper level discriminator settings are controlled directly from the desktop computer. For operation with other types of detector systems such as alpha spectrometers or single photon counting, a DIRECT input is provided to bypass the scintillation amplifier and allow direct access to the ADC.

A 2048 channel ADC with de-randomizing buffer offers excellent data throughput at high counting rates with minimal dead-time losses. Conversion gain may be changed from 2048 to 1024 to 512 or 256 channels via the software. Data from the ADC is stored directly in on-board memory for autonomy and high-speed operation, freeing the host computer for other tasks.

Software

The UCS-20 produces a high-resolution, real-time live color display of spectral data with standard PC graphics running under Windows (95 and above). Operation is intuitive
using pull-down menus and function buttons for the most commonly used commands and display options. The software offers full control of all features including preset live/real time, and regions-of-interest together with centroid, gross and net area calculations.

Control of the hardware amplifier, high voltage, ADC and input discriminators is also through function buttons for straightforward calibration and operation. To simplify identification of peaks, the cursor may be calibrated to read directly in energy units, using either a 2-point linear, or 3-point quadratic relationship to allow for detector non-linearity.

Spectral files may be transferred to disk for long-term storage as binary files or transferred through the clipboard in ASCII format for exporting to other programs. Stored files may be used to collect background data over a long counting period that can be subtracted on a time proportional basis from the spectral data.

To aid in the identification of nuclides, the UCS-20 contains a unique peak-labeling feature named ISOMATCH. Providing the unit is accurately energy calibrated, the user may select a nuclide from the library and the corresponding characteristic emission lines are superimposed on the spectrum along with isotope and energy information. Using this feature, users may quickly check a spectrum and visually identify the emission components for each nuclide present. The ISOMATCH libraries may be created or customized using a text editor.

When operating in multi channel scaling mode, the system may be calibrated in time units for direct readout from the cursor.

Both linear and logarithmic vertical display ranges are included which can be useful when performing decay studies

Spectrum files, can be transferred from the ICS 10 DOS program and the ICSW 16 Windows program to the UCS20 Windows version.

Most functions may be accessed by more than one method. All the functions can be accessed from the Pull Down Menu, some from the Tool Bar Buttons, or by the mouse. If the function has a Tool Bar Button, its symbol will be shown on the left hand side of the description.
Screen View

---

*IDH_INTROSCREENVIEW

{Screen View}

---
Installation

System Requirements
The UCS20 instrument uses a Universal Serial Bus (USB) to communicate with a PC. The PC must have USB compatible drivers, which are available standard on Windows 98 and later releases. Windows 95 must have the USB upgrade or patch to work. The performance of the USB on older systems may affect the perceived performance of the software; so we recommend that you use a Pentium 2 or greater class of microprocessor running at 250 mHz or greater to achieve desirable performance. The executable code is less than 600 kb, but the help files are more than 5 mb; so if you have limited disk space, you may wish to leave the help files on the CD.

Installing Software
Connections On Rear Panel
Uninstalling Software
Connections On Rear Panel

The UCS-20 is equipped with an internal Amplifier/Preamplifier allowing direct connection of a scintillation detector. If you plan to use this feature, connect the signal (anode) output of the detector tube base to the PREAMP IN connector on the rear of the instrument using a BNC cable and connect the high voltage to HIGH VOLTAGE with the MHV cable

These cables appear similar with the MHV being slightly longer than the BNC

**WARNING – ELECTRICAL SHOCK HAZARD**

TO AVOID ANY POSSIBILITY OF ELECTRICAL SHOCK, ALWAYS TURN OFF THE INSTRUMENT POWER BEFORE CONNECTING THE EXTERNAL CABLES. DANGEROUS HIGH VOLTAGE CAN EXIST ON THE EXTERNAL HV CONNECTOR WHEN THE UNIT IS OPERATING. NEVER REMOVE OR CONNECT CABLES WITH THE INSTRUMENT RUNNING.

SERVICE BY AUTHORIZED PERSONNEL ONLY.

---

**Rear Panel**

**HV Output:** MHV (or optional SHV) connector supplies positive 0 - 2500 volt @ 1mA maximum current to power scintillation detector. High voltage is fully regulated and computer controlled in 25 volt increments.

**PREAMP IN:** BNC connector for direct connection to PMT anode signal. Uses internal
amplifier/preamp.

**AMP IN:** BNC connector for signal connection to external preamplifier.

**DIRECT IN:** BNC connector for connection to external amplifier. Bypasses internal amplifier and connects directly to ADC input. Accepts unipolar or bipolar signals 0-8volt range.

**EXT MCS:** BNC connector to input positive MCS TTL pulses > 150nsec. 5 MHz maximum rate.

**ROI OUT:** BNC connector supplies a pulse out when data is acquired in a channel marked as a ROI. The pulse width is adjustable from 100usec to 25 msec by an internal pot. The pulse amplitude is adjustable from 0volt to 7.5 volts by an internal pot.

**GATE IN:** BNC connector for connection to external coincidence unit. A positive TTL pulse causes the ADC to accept the next pulse. The Gate pulse must be present before the peak of the input Pulse. Gate pulse width = 50nsec to 2usec.

**MSB OUT:** (OPTIONAL) BNC connector to output the most significant MCS bit for Mossbauer Applications.

**T/COMP:** Modular connector for connection to temperature compensated tube base.

**HIGH VOLTAGE:** MHV (OPTIONAL SHV) connector supplies positive 0 to 2500 volts to power scintillation detectors and proportional tubes. 1-Watt maximum Power available.

**USB:** Universal Serial Bus connector for communication with computer.

**PREAMP POWER:** (OPTIONAL) DB-9 connector, supplies + – 12v power for External preamplifier.

When using an external amplifier system, connect the amplifier unipolar or bipolar output to the **DIRECT IN** connector.
Installing Software

Insert the included CD in your CD-ROM drive. The install program will automatically run. Follow the instructions to select the options you want to install.

The application is less than 600 kb, but the help files are greater than 3 mb; if you have limited disk space, you may not want the help file installed. You can access the help file on the CD.

The default installation directory is C:\SpecTech\UCS20

Example files

**Spectrum (*.spu) files:**
Normal.spu – contains an uncalibrated spectrum of CS-137.
Calibrated.spu – contains a calibrated spectrum of CS-137.

**Setup (*.sup) files:**
Normal.sup – has settings used in Normal.spu.
Calibrated.sup – has settings used in Calibrated.spu.

Library (*.itm) files
Isotopes.itm – contains a list of common isotope peaks for use with the IsoMatch function.
#Uninstalling Software

Go to the Windows Start Menu, select Settings, then Control Panel. On the Control Panel, select Add/Remove Software. Find UCS20, double click and follow the instructions.
Analysis Modes

See:

- Pulse Height Analysis
- Multi Channel Scaling
- External Multi Channel Scaling

#IDH_MODES
^Analysis Modes
^Analysis Modes
^Analysis Modes
^Analysis Modes
This is the normal operating mode for collecting sample gamma emission spectra. The amplitude of each detector pulse is measured by the ADC and stored as an amplitude (energy) spectrum.

The X axis is scaled to the selected channels and the Y axis is scaled for the counts for each channel. Y axis counts that exceed the maximum Y axis value are ‘wrapped’, they no longer are scaled to the Y axis, and they appear in a different color.
Multi Channel Scaling mode is used for measuring time related phenomena such as half-life decay or single photon counting. The ADC is bypassed and incoming events are routed directly into memory for specific predetermined times (dwell time) and stored in sequential memory locations.

To use this mode, first acquire a spectrum using the Pulse Height Analysis mode. While acquiring the spectrum, adjust the LLD and the ULD to select the energy range of interest (for example, selecting only the 662 keV peak form CS-137 can eliminate unwanted background and produce a superior decay curve when using a Cs-137/Ba-137 mini-generator.)

Click the Mode menu and select MCS

$^a$IDH_MODESMCS
$^b$Multi Channel Scaling
$^c$Multi Channel Scaling
Click the Settings menu and select MCS

Enter the Dwell Time. This time is for each memory location (channel). Remember the total pass time will be (Conversion Gain x Dwell Time).

Erase any current memory data and click start. The UCS20 will proceed to count incoming events for the selected dwell time, store the total in the first channel location, reset the counter and repeat the cycle storing each total in sequential channels.
External Multi Channel Scaling

If you wish to use an external pulse generation system such as a coincidence circuit, it will be necessary to bypass the on-board amplifier and discriminators. Connect the external counts connector to the Ext MCS connector on the back of the instrument and select the menu item MODE then select External MCS.

When operating in this mode, the MCS input requires positive TTL signals (>2.5V, >150 ns duration).
Operation

Screen View
Live Mode
File Mode
Amp/HV/ADC
Presets
Go, Stop and Erase
Region of Interest (ROI)
Live Mode

The software starts up in the Live Mode. This mode uses the USB to communicate with the instrument.

If you access the File Menu and click on Open, a new window appears which looks like the current window, except that the title bar shows ‘File Mode’ instead of ‘Live Mode’. File mode does not communicate with the instrument and is used only to view and manipulate files that have been saved to disk.
File Mode

File Mode is accessible from the live mode by going to the File Menu and clicking on Open. Select the file you want to view. Some functions, which have no use when viewing files, are disabled in the Menus and the Toolbar.
Click the Amp/HV/ADC Button on the toolbar:

Or use the settings menu and click on Amp/HV/ADC

The Amp/HV/ADC dialog box will appear.

Adjustments may be made to the amplification, high voltage, conversion gain, low level discriminator, and the high level discriminator.
Selecting OK will cause these values to be written to the UCS20 instrument.

**Configuring System Parameters:**
Once the program is running it will be necessary to configure the system parameters for correct operation and calibration.

Place a gamma emitting check source near the detector face. Cesium-137 (Cs-137) is a good choice. It has single peak at 662 keV.

Click on Settings, then click on Amp/HV/ADC
Set the high voltage to the voltage as listed by the detector manufacturer. As an example, set the high voltage to 600 volts, click ON.

*DO NOT* exceed the maximum high voltage rating of the detector, usually 1200 volts.

Set the amplifier **COARSE GAIN** to 8, and set the **FINE GAIN** to 1 as a starting position. Click on **OK**, to set adjustments and exit the menu.

**Start** the data acquisition and adjust the **amplifier gain** until the 662 keV peak is approximately mid-scale.

Once the acquisition is started, you may enter the Amp/HV/ADC menu, make adjustments while viewing the spectrum. This will allow you to position the peak in the desired channels.

<table>
<thead>
<tr>
<th>High Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplifier Coarse Gain</td>
</tr>
<tr>
<td>Amplifier Fine Gain</td>
</tr>
<tr>
<td>ADC Conversion Gain</td>
</tr>
<tr>
<td>Lower and Upper Level Discriminators</td>
</tr>
</tbody>
</table>
High Voltage may be entered directly in the text box or may be scrolled to the value desired. A warning will be issued if you attempt to input a value higher than 1200 volts, since this is the highest value that many probes can tolerate without damage. If you know that your probe can accept higher than 1200 volts, you may increase the voltage up to 2500 volts.

See also:

Amp/HV/ADC
Amplifier coarse gain may be set by clicking the radio-button next to the desired multiplier.

See also:

Amp/HV/ADC
Amplifier fine gain may be directly entered as a multiplier value between 1.0 and 2.55.

See also:
   Amp/HV/ADC

---

IDH_SETTINGSFINEGAIN
Amplifier Fine Gain
Amplifier Fine Gain
ADC Conversion Gain

Conversion Gain represents the number of channels that will be sampled and displayed on the screen. Smaller values save as smaller files.

The conversion gain default setting is 1024 channels. This is preferred for most scintillation detector applications and generally no adjustment is required.

For certain applications, such as alpha spectroscopy, it may be necessary to change this parameter to either 256, 512, or 2048 channels.

See also:

Amp/HV/ADC

---

*KADC Conversion Gain*  
*IDH_SETTINGSADCConversionGain*  
*ADC Conversion Gain*  
*ADC Conversion Gain*
Lower and Upper Level Discriminators

LLD and ULD, Lower Level Discriminator, and Upper Level Discriminator, allow the user to set a value between 0 and 106 (roughly percent) that cuts off signal before it gets to the ADC. The LLD is often used to block high-count signals in the low range that are not of interest, but require excessive time to sample. The ULD may be set up to 106. Low level discrimination (LLD) may be scrolled or directly entered.

Upper level discrimination (ULD) may be scrolled or directly entered.

An alternative method to change the LLD and ULD is to use the mouse to move the triangles under the X axis. Move the mouse over the triangle to be moved, press the left button, drag the triangle and release it where desired. The software will not allow the LLD and the ULD set outside appropriate ranges.

See also:
Amp/HV/ADC

#IDH_STARTUPLLDDLULD

### Lower and Upper Level Discriminators

### Lower and Upper Level Discriminators
Presets

Preset Time
The real time count and the live time count may be changed using the Preset function.

Preset Integral
The instrument can be set to stop automatically after a ROI integral.

Click the Preset Time Button on the toolbar:

Click the Preset Integral Button on the toolbar:

Or use the settings menu and click on Presets

For details see:

Preset Time
Preset Integral

* IDH_PRESETS
* Presets
* Presets
Preset Time

Preset Live Time provides automatic correction for counting losses caused by the system deadtime. Events which occur during the pulse processing cycle are lost to the system so the timer is automatically updated to compensate for these losses. When operating at excessively high count-rates the deadtime meter will indicate a high value and the real counting time may be more than doubled. Increasing the LLD setting can help reduce some high deadtime effects.

Preset Real Time sets the counting timer to run for actual clocktime and makes no correction for losses due to deadtime effects.

Click on Settings, click on Presets
Enter the LIVE or REAL time in the correct box. Click on OK, to set adjustment and exit menu.

Both the LIVE TIME and REAL TIME values are displayed on the UCS20 status bar as LT and RT. These values are saved in the file during data storage.
Set Integral
To set an integral count it is necessary to first establish a ROI and then position the marker within the region.

Selecting an ROI and setting a value other than 0 in preset integral will cause the system to STOP counting when the total of all the channels within the ROI reaches that value.
Go, Stop and Erase

Go, Stop and Erase functions are accessed with the Tool Bar buttons. Clicking on Start begins data collection. Clicking on Stop ends data collection. Clicking on Erase sets each channel’s data to zero.
Region of Interest (ROI)

Region of interest (ROI) selection is an advanced feature which provides instantaneous computation of peak gross and net counts. These values may be used along with isotope decay tables and detection efficiency to calculate absolute or relative isotopic activities. ROI’s must not overlap and need to be separated by at least one channel for correct area calculation. Up to 16 different ROI’s are possible using the color selector from the pull down Settings menu.

Set ROI
To set an ROI around a peak, click the ROI button on the Tool Bar. Click the left mouse button at the beginning of the ROI, hold down the left mouse button and drag the marker to the other side of the peak, release mouse button.

Clear ROI
Move marker to the ROI to be cleared. Open the Setting Menu, open ROI and select Clear ROI.

Gross and Net Count

When the marker is positioned in a region of interest (ROI), the UCS20 software automatically calculates the Gross and Net area of the region. In order to minimize statistical effects at the ROI endpoints, a 3-point averaging technique is applied. The contents of channels \((n-1), (n), \text{ and } (n+1)\) are summed and averaged to derive the content of the endpoint channel for the net area computation. A linear interpolation is performed between these averaged endpoint values and counts below this interpolation are

IDH_OPROI
Region Of Interest
Region Of Interest
subtracted to arrive at the **Net** area of the peak. Gross counts is the sum of all channels in the **ROI**.

Position the marker in the peak of interest. The **Gross** and **Net** areas are automatically computed and displayed on the spectrum screen.

**Preset Integral**
Functions

Energy Calibration
Isotope Matching
Strip Spectrum
Smoothing

#IDH_FUNCTIONS
#Functions
#Functions
The energy calibration feature allows the marker to read directly in energy units. Two calibration functions are possible, a 2-point linear, or a 3-point quadratic fit.

In order to perform an energy calibration, it is first necessary to acquire a spectrum using known isotopes. Cs-137 together with Co-60 works well for many applications, producing gamma lines at 32 keV, 662 keV, 1173 keV and 1332 keV.

Select 2-point or 3-point mode and enter the calibration units to be used, (keV or MeV). Position the marker at the highest channel of the first peak and enter the peak energy value. Move the marker to the high point on the second peak to be used for the calibration, enter energy number. If a 3-point calibration is required, continue by moving the marker to the peak channel of the third peak, enter its energy and click OK. The system will now be calibrated and the marker position will read directly in energy.

To return to the channel number mode, click on Settings, click on Uncalibrate. Energy Calibration may also be selected using the right mouse button.
Isotope Matching

Displaying Isotope Peaks
Isotope peaks may be indicated on calibrated spectra. These peaks are selected from a list provided by selecting the Display menu and clicking on Iso Match. The following dialog box will be displayed:
Click the isotopes peaks in the left window that you want to display. These will be transferred to the right window. When your list is complete, click Okay to display them.

**Editing the Iso Match list**
Select the **Edit** menu and click **Iso Match**. The following dialog box will be displayed:

![IsoMatch Library NOT loaded.](image)

![IsoMatch Library IS loaded](image)

IsoMatch Library NOT loaded.  IsoMatch Library IS loaded

The dialog box top window labeled ‘Select an existing isotope’ will be empty unless an Iso Match library has been loaded. If a library has been loaded, you can select on of the entries from the window, if a library has not been loaded, or you want to add an entry to
the list, enter the name in the second window titled ‘or enter and isotope name’. Enter the number of peaks you want to add for this isotope in the third box labeled ‘Enter number of peaks [10 max]’ and click on Edit.

Further dialog boxes will appear that allow you to enter peak(s) for the isotope.

If you want to save the Iso Match to a disk file, open the File Menu and click on Save Library.
The Strip Background option is available only in the File Mode. The user may load two files (Spectrum and Background) and subtract the second file from the first. The portion subtracted is based on a time adjustment to the data in the second file. For example if the first file was measured with 100 seconds live time and the second file was measured with 200 seconds live time, then the data in the second file is divided by 2 (200 seconds / 100 seconds) before it is subtracted.

**Background Subtraction**
This is a special case of spectrum stripping. Collect a background sample spectrum, usually for a long collection time. Load this spectrum as Background and click on ‘Strip Background from Spectrum.’ The live time fraction of the background is subtracted from spectrum. This provides a convenient method of removing naturally occurring background from a sample spectrum and can be very useful when working with low level environmental samples.
Load Spectrum

Click on **Load Spectrum** and in the **File Dialog Box** that opens, select the spectrum you intend to have the background stripped from. For example, the spectrum may be taken for an isotope, the background may be the readings with no isotope present.
Load Background

Click on **Load background** and in the **File Dialog Box** that opens, select the background you intend to strip from the first. For example, the spectrum may be taken for an isotope, the background may be readings with no isotope present.
Click **Show Spectrum** to view spectrum.
Click **Show Background** to view background.
Click Overlay Spectra to view the spectrum and the background at the same time.
Click **Strip Background from Spectrum** to subtract the two spectra, where the background is corrected for the difference in the data collection time to give a correct proportion.
Data Smoothing

Click **Smooth Data** to perform a 3-point averaging of the data currently being displayed. The function uses the following algorithm to average data in each channel, where ‘n’ is the channel number.

\[
\frac{(n-1)+(n)+(n+1)}{3}
\]
Many advanced functions are possible via the pulldown menus. This section describes each operation in the sequence they appear. Black letters indicate the function is operational, gray indicates not-operational, highlighted indicates the function to be activated.

For details:

File
Edit
Mode
Display
Settings
Strip
View
Help
For details:

- **File Open**
- **File Save**
- **File Load Setup**
- **File Save Setup**
- **File Load Library**
- **File Save Library**
- **File Print**
- **File Print Preview**
- **File Print Setup**
- **File Exit**
**File Open**

**File Open** allows the user to open data files. A new instance of the UCS20 application in the File Mode is generated.

See Also:

- Window Live Mode
- Window File Mode
File Save

The spectrum data and the associated setup and experiment data are saved to a *.spu file.
Once the UCS20 has been setup and calibrated, all operating parameters may be stored (Save Setup) as a disk file for subsequent retrieval. If power has been turn off, it is a simple and convenient process to reload the setup file and quickly restore (Load Setup) the analyzer to its previous operating condition.

*High Voltage must be turned on after loading setup!*
File Save Setup

Once the UCS20 has been setup and calibrated, all operating parameters may be stored (Save Setup) as a disk file for subsequent retrieval. If power has been turn off, it is a simple and convenient process to reload the setup file and quickly restore (Load Setup) the analyzer to its previous operating condition.
File Load Library

Allows loading of an Iso Match library file (*.itm).

See also:
   Isotope Matching
File Save Library

Allows saving of an Iso Match library file (*.itm).

See also:

Isotope Matching
File Print

Allows the user to print the displayed spectrum.
File Print Preview

Allows the user to preview the spectrum as it will be printed.
File Print Setup

Allows the user to adjust the printer parameters before printing.
File Exit

Closes the application.
For details see:

- Edit Experiment
- Edit Iso Match
- Edit Smooth Data
**Edit Experiment** provides a means of inserting text into spectral file headers for referencing specific measurements. This text is saved along with data and parameter information in .SPE and .TSV files, and it is used for the Peak Report and the Data Report.

Enter the desired text into the dialog box and click Okay when finished.
# Edit Iso Match

**Edit Iso Match** allows the user to edit isotope data, add and delete isotopes from library.

See also:

- Isotope Matching
Edit Smooth Data

Edit Smooth Data allows the user to apply a three-point smoothing algorithm to the displayed data.

For details see:
  Data Smoothing
For details see:

- Mode Pulse Height
- Mode Multi Channel Scaling
- Mode External MCS

IDH_MENUMODE
Mode
Mode
Mode
Mode Pulse Height

Click on **Pulse Height** to select the Pulse Height Mode.

See:  
* Pulse Height Analysis
Mode Multi Channel Scaling

Click on Multi Channel Scaling to select the Multi Channel Scaling Mode.

See: Multi Channel Scaling
Mode External Multi Channel Scaling

Click on **External MCS** to select the External Multi Channel Scaling Mode.

See:  

[External Multi Channel Scaling](#)
Display

For details see:

Display Peak Report
Display Data Report
Display Calibration
Display ROIs
Display Iso Match
Display Pixel Size
Display Peak Report

If regions of interest have been set around peaks in a spectrum, the Peak Report provides a convenient method of displaying peak information in tabular form. Readout will be in energy units if the energy calibration is active.
#SK Display Data Report

The **Data Report** includes all hardware setting, counting parameters and spectrum data. ROI data is reported by lower and upper channels set, gross, net, FWHM, centroid, all channels and corresponding counts.
Display Calibration

Display Calibration allows the user to switch between on/off in calibration mode and channel numbers or energy is displayed on the horizontal line.
Display ROIs

Display ROIs lets the user toggle between displaying and not displaying the ROIs.
Display Iso Match lets the user toggle between displaying and not displaying the Iso Match peaks.

#SK Display Iso Match

IDH_MENUDISPLAYISOMATCH

Display Iso Match

Display Iso Match
Display Pixel Sizes

Allows the user to choose between 1, 2, and 3 pixels per data point displayed. The default is 2.
# Settings

## Presets
- Clear ROI
- Set ROI

## Presets
- Preset Time
- Preset Integral

## Amp/HV/ADC
- High Voltage
- Amplifier Coarse Gain
- Amplifier Fine Gain
- ADC Conversion Gain

lower and Upper Level Discriminators

---

8IDH_MENUSETTINGS
9Settings Menu
\*Settings Menu
Settings ROIs

Allows the user to select the option to set or clear an ROI.

See:

- Clear ROI
- Set ROI
Clear ROI

Clicking on **Clear ROI** will clear the ROI indicated by the marker.
Clicking on **Set ROI** allows the user to set the ROI.

See also: [Region of Interest (ROI)](#IDH_MENUSETTINGSROISETROI)
#SK Settings Energy Calibrate

Opens a submenu for calibrating and uncalibrating the spectrum.

See:
- Settings Energy Uncalibration
- Settings Energy Calibrate 2 Point
- Settings Energy Calibrate 3 Point

*IDH_MENUSETTINGSENERGYCALIBRATE
^Settings Energy Calibrate
&Settings Energy Calibrate
Settings Energy Uncalibrate

Clicking **Energy Uncalibrate** will undo energy calibration and return the spectrum to the channel mode of data display.

See:  

Energy Calibration

---

^IDH_MENUSETTINGSENERGYUNCALIBRATE
^Settings Energy Uncalibrate
^Settings Energy Uncalibrate
Settings Energy Calibrate 2 Point

Clicking 2-Point allows the user to calibrate the date using two points.

See: Energy Calibration
Settings Energy Calibrate 3 Point

Clicking **3-Point** allows the user to calibrate the date using three points.

See:

Energy Calibration
#K Settings Preset

Clicking **Presets** allows the user to select the Presets Dialog box.

See:
- Preset Time
- Preset Integral
Clicking **Amp/HV/ADC** allows the user to select the Amp/HV/ADC Dialog box.

See:

- **Amp/HV/ADC**
  - High Voltage
  - Amplifier Coarse Gain
  - Amplifier Fine Gain
  - ADC Conversion Gain
  - Lower and Upper Level Discriminators
Settings MCS

Clicking MCS allows the user to access the MCS Dwell Time dialog box, if the Mode is set to MCS.

Scroll to the desired Dwell Time then highlight the value selected then press OK.

See: Multi Channel Scaling
Settings Color

Clicking **Color** allows the user to select the **Colors Dialog Box** to set or change the colors for the ROIs, Background, .

![Color Dialog Box](image)

The **Color Dialog Box** allows the user to select custom colors for ROIs, Plot Background, Plot Border and Text.

Select the item to change, click on **Change**, select the desire color, click on **OK**, returns to the **Color** screen, make additional color changes, when all color changes have been made, click on **OK**, enters data and returns to spectrum screen.

**Color** allows the user to select a range of **Basic Colors** or create **Custom Colors**.

---

---

-IDH_MENUSETTINGSCOLOR

-Settings Color

-Settings Color
Dialog Box with standard Colors.

Dialog Box expanded for custom colors.

**Note:**
Setup of computer graphic may affect the true color of the color selected.
Strip Background

Allows the user to load a spectrum and a background and then strip the background from the spectrum.

See:

Strip Background

#IDH_MENUSTRIP
 Strip Background
 Strip Background

#K Strip Background

Strip Background
Strip Background - Load Spectrum

See:

Load Spectrum
Strip Background - Load Background

See:

Load Background

---

*IDH_STRIPLOADSPECTRUM2
Strip Background – Load Background
Strip Background - Show Spectrum

See:
  Show Spectrum

*IDH_STRIPSHOWSPECTRUM1
^Strip Background – Show Spectrum
^Strip Background – Show Spectrum
Strip Background - Show Background

See:

Show Background
# Strip Background – Overlay Spectra

See:  

Overlay Spectra
Strip Background – Strip Background from Spectrum

See:

Strip Background from Spectrum
View

Allows the user to display or not display the Tool Bar and/or the Status Bar.

- Tool Bar
- Status Bar
Tool Bar

Allows the user to display or not display the Tool Bar.
#SK Status Bar

Allows the user to display or not display the Status Bar.
The **Help** menu provides a convenient operator reference for the UCS20 in the standard Windows Help format.
Contents

The Help menu provides a convenient operator reference for the UCS20 in the standard Windows Help format.
The **Using Help** item provides the standard Windows Help on using the Windows Help system.
About

Displays a splash screen with the Application name and version number.
Tool Bar

Go
Stop
Erase

Show Peak Report
Show Data Report

Amp/HV/ADC
Presets

ROI

Spectrum Window Sizing
Y axis Increase
Y axis Decrease
Y axis Log
X axis expand
X axis contract
X axis right 256 channels
X axis right 16 channels
X axis left 16 channels
X axis left 256 channels
**Go** allows the user to start the acquire mode of a spectrum. This can also be accomplished by clicking on the green start icon on the display screen.

See: [Go, Stop and Erase](#)
Stop allows the user to stop the acquire mode of a spectrum. This can also be accomplished by clicking on the red stop icon on the display.
See:  
Go, Stop and Erase
Erase allows the user to erase the spectrum when in stop mode. This can also be accomplished by clicking on the Eraser Icon on the display screen.

See:

Go, Stop and Erase
Show Peak Report

If regions of interest have been set around peaks in a spectrum, the Peak Report provides a convenient method of displaying peak information in tabular form. Readout will be in energy units if the energy calibration is active.
Show Data Report

Data Report includes all hardware setting, counting parameters and spectrum data. ROI data is reported by lower and upper channels set, gross, net, FWHM, centroid, all channels and corresponding counts.
Amp/HV/ADC

Allows the user to select the **Amp/HV/ADC** Dialog box.

See:

- Amp/HV/ADC
- High Voltage
- Amplifier Coarse Gain
- Amplifier Fine Gain
- ADC Conversion Gain
- lower and Upper Level Discriminators

---

*IDH_TBAMPHVADC
  ^AMP/HV/ADC Button
  ~AMP/HV/ADC Button
Presets

Allows the user to select the **Presets** Dialog box.

See:

- Preset Time
- Preset Integral

---

^IDH_TBPRESETS
^Presets Button
^Presets Button
#ROI

Allows the user to set an ROI.

See:

Region Of Interest
Spectrum Window Sizing

These buttons allow the user to set the size of the X and Y axes.

If a button is grayed, its function is not available for use.
Y axis Increase

Clicking the Y axis increase button doubles the magnitude of the Y axis.
**Y axis Decrease**

Clicking the Y axis decrease button halves the magnitude of the Y axis.
"Y axis Log"

Clicking the Y axis Log button sets the Y axis to a logarithmic scale with a maximum of 16 meg.
X axis expand

Clicking the X axis expand button increases the span of the X axis, up to the maximum set by the Conversion Gain.
X axis contract

Clicking the X axis contract button decreases the span of the X axis.
$X$ axis right 256 channels

Active if there are 256 channels to the right of the displayed $X$ axis span. Clicking this button will shift the $X$ axis span 256 channels to the right.
X axis right 16 channels

Active if there are 16 channels to the right of the displayed X axis span. Clicking this button will shift The X axis span 16 channels to the right.
X axis left 16 channels

Active if there are 16 channels to the left of the displayed X axis span. Clicking this button will shift The X axis span 16 channels to the left.
$X$ axis left 256 channels

Active if there are 256 channels to the left of the displayed X axis span. Clicking this button will shift The X axis span 256 channels to the left.

---

*IDH_TBXL256
*X axis left 256 Button
KUSC20 Topics
### Status Bar

The status bar at the bottom of the window displays a context sensitive help message on the left side, the high voltage, live time, real time, and selected device on the right side.
Specifications

Hardware
Software
**Hardware**

**Physical:** Single instrument includes preamplifier, amplifier, detector high voltage, 2048-channel multichannel analyzer with data memory, LLD and ULD. Fully compatible with many scintillation detectors and commercial tube bases.

**Amplifier:** On-board combination preamplifier/amplifier for use with scintillation detectors and PMT's. Computer controlled coarse and fine gain from (x) 1 to (x) 160.

**ADC:** Wilkinson type with 80 MHz clock and computer selected conversion gain of 2048, 1024, 512, or 256 channels. Direct input accepts pulse peaking times of 1 µsec. to 10 µsec. Includes dead-time correction when used in Live-time mode.

**LLD & ULD:** Independently computer controlled in 4-channel increments over entire input range. Operates prior to ADC for reduced system dead time.

**Modes:** MCA for pulse height analysis, or MCS for half-life decay or other time related studies.

**Timers:** Real-time or Live-time operation selectable in 1-second increments for PHA, or dwell times from 10 msec. to 600 seconds per channel in MCS mode.

**Data Memory:** On-board static RAM, 2048 channel (x) 3 Bytes for data, plus region-of-interest flag.

**Deadtime:** System dead-time is computed and displayed on screen during acquisition.

**Power:** AC line powered with an auto sensing power supply for 100 – 250 VAC, 10 watts total.

**Connections On Rear Panel:**

Connections On Rear Panel
System: Operates under Microsoft Windows® 98, Windows® 2000, Windows® XP with 600 kb for the executable and 5 meg for the optional help file available disk space, 32 meg RAM (48 recommended), and compatible mouse.

Display: VGA or SVGA color graphics (800x600 recommended. Vertical scale adjusts from 32 to 16M and LOG display. Horizontal 2048 channels with reduction down to 256 channels.

Time Mode: Preset live-time or preset real-time selection. Both times are recorded and displayed.

ROI'S: Multiple Regions-of Interest using color coding.

Integral: When cursor is in ROI, computes gross area, net area with end point averaging, centroid and FWHM.

Energy Cal: 2-point linear or 3-point quadratic converts cursor position reading directly to energy units. (Time units in MCS mode.)

Strip: Subtracts channel-by-channel time normalized data stored in File Mode. Overlays two saved spectra in File Mode.

Smooth: 3-point smoothing of selected displayed data.

Control: Software control of High Voltage, Amplifier Gain, Lower and Upper level discriminators, and ADC Conversion Gain.

File: Save or load data file and header information in binary, or spreadsheet compatible formats.

Print: Prints current screen display to Windows printer.

ROI File: Saves ROI data, centroid, FWHM, gross and net integrals, and header information in spreadsheet compatible format.

ISOMATCH: Isotope library text file with peak markers and labeling for overlaying on spectrum for quick isotope identification. Library may be edited from Edit, IsoMatch pull down menu.

*IDH_SPECSW
*Software Button
*Software Button
SPECTRUM TECHNIQUES, INC.
106 Union Valley Road
Oak Ridge, TN 37830
USA
Tel. (865) 482-9937    Fax. (865) 483-0473
e-mail: support@spectrumtechniques.com
Web Site: http://www.spectrumtechniques.com